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Safety Precautions  Please Read Carefully 
The precautions that must be followed in order to ensure that the product is safely used and to prevent 
personal injury or damage to your property or the property of others are explained below in the manual. 
Read the “Safety Precautions” carefully before handling the product.  

 This chapter uses the following safety classifications to denote the type of injury or damage that 
may result from improper operation or failure to follow the safety indication. 

 

Warning Indicates information that, if ignored, could cause death or severe 
injury, or that could cause material damage. 

 

Caution 
Indicates information that, if ignored, could cause severe injury or 
material damage. 

 The following icons are used to classify and indicate proper usage. 

Icon Explanation 

 
Indicates a mandatory instruction. 

 

Prohibition 
Indicates a generally prohibited action.  

 

Entanglement danger 
The danger of entanglement resulting in serious injury exists. Use 
extreme caution. 

 

Laser caution 
The danger of blindness and severe exposure injuries exists. Use 
caution.  

 

Pinch caution 
The danger of injury resulting from fingers being pinched in an 

opening exists. Use caution. 

 

Rotating object caution 
The danger of damage resulting from rotating objects exists. Use 
caution. 

 

General caution 
Pay attention to the indicated content. 

Definitions of the terms used in this manual are as follows: 

Severe injury: An injury—such as loss of sight, wound, burn (high or low temperature), electric 
shock, bone fracture, or poisoning-that has aftereffects or that requires 
 hospitalization or long—term medical treatment. 

Injury: An injury—such as a wound, burn (high or low temperature), or electric 
shock—that requires hospitalization or long-term medical treatment. 

Material damage: Significant damage to buildings, property, livestock, or pets. 

User: Indicates the person using this system. This may include the original purchaser, 
the purchaser’s customers, or anyone who has been granted use of the system 
by the purchaser. 
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 Warning 
 

 

Do not use excessive force on the device’s power cord. 

Doing so may cause fire, electric shock, or damage. 

 

Never change the specifications, modify, or disassemble this product. 
Doing so may cause fire, electric shock, or damage. Additionally, overheating or improper 
operation could cause severe injury. 
Consult Pulstec should this occur. 

 

 

Do not place liquids, such as water, near the device. 

If liquid comes into contact with the device’s internal components, fire, electric shock, or 
damage to the device could occur. 

 

 

Immediately halt use if a strange odor issues from the device. 
Electrical shock or fire could occur. 
Contact Pulstec for inspection and repair.  

 

 
 Caution  

 

Use this device in a proper operating environment. 
Failure to do so could cause fire or damage the machine.  
* Use in accordance with operating environment conditions.  

 

Do not dispose of device as general waste.  
Dispose of device in accordance with all applicable local, state, and federal laws. 
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Pulstec’s liability 
Warranty conditions 

The warranty for this device is valid for one year, starting from the date of delivery to the specified destination 

and continuing up to the same month and date of the following year. Consumables* and item to be supplied are 

not covered by the warranty. 

* See the product specifications or contact a sales representative for further details. 

The warranty for any item purchased on the open market shall be as set by that item’s manufacturer. 

Even if occurring within the warranty period, the user shall be required to pay for servicing and repair 
of any breakdown caused by the user’s attempt to repair or modify this equipment, by the user’s 
operational error, or by natural calamity. 

Pulstec shall bear no liability whatsoever for damage, lost profits, or other losses that occur as a result 
of using this device.  

In addition, the user shall be required to pay for any maintenance and repair carried out overseas, 
even if occurring within the warranty period. 
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1.1 Device Configuration 
1.1.1 System Configuration 

This system consists of the BW10 and a computer for setting control parameters. The BW10 and 
computer are connected with a LAN cable. 
A single computer can control a maximum of 5 units.  

A handler interface can also be used to communicate with an external disc handling device to 
transport discs.  
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1.1.2 Operating Environment 
Follow the conditions indicated in the chart below.  

BW10 

Item Specification 

Allowable Input 
Voltage AC 90 to 230V 

Power 
Consumed Current Idle 1.0A  (100V) 

Operating 3.0A  (100V) 

Environment During Use 
Temperature 23±5°C 
Humidity 80% or less (No internal or external 
condensation) 

Air Air Pressure 0.5±0.05Mpa 

 

Application Operating Environment 

Item Specification 

CPU Pentium IV 2.4GHz or higher 

RAM 512MB or higher 

HDD 10GB or higher (not including saved data) 

OS Windows XP Professional 

Computer 

LAN IEEE 802.3 

Number of Pixels 1024×768 (XGA) or higher 
Monitor 

Color 32Bit 

* Do not install additional applications or drivers on the control computer. In addition, do not run 
other applications during operation.  

 

 

 

 

 

 

 

The name Windows® is short for Microsoft® Windows® Operating System. Microsoft and Windows 
are registered trademarks of the Microsoft Corporation in the USA and other countries. Other 
company names and product names used herein are trademarks or registered trademarks of their 
respective owners. 
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1.1.3 Device Specifications 

Recording Side PUH Section (SB-21A:Pulstec) 
1) Wavelength 805nm±10nm 
2) N.A. 0.62 
3) Output Laser Power 4,800mW 
4) Laser Form on a Disc 40×1um 
5) Etc. 1 Axis Actuator 2LD Type 
6) Working Distance 1.56mm 
7) Environment Temp. 25±5°C 
8) Environment Hum. No condensation 
9) Lifetime 3,000 hr* 

* The life of the laser differs depending on the target disc characteristics, read parameters, 
  and operating environment. 

Disc Loading Method 
1) Disc Loading Turn Table (Tray type) 

PUH Feeding Section 
1) Seeking Part PUH 
2) Motor Stepping Motor 
3) Feeding Mechanism Ball-screw 
4) Feeding Resolution 1um/Step 

Spindle Motor Section 
1) Motor DC Brush less motor 
2) Output A,B,Z 
3) Index Pulse Resolution 500 pulse/rev 
4) Rotation Litter ±0.0003% 
5) Spin-up Speed 100±30ms (0→600rpm) 

Disc Clamping Section 
1) Clamping Magnetic clamper 
2) Clamping Force 2.0±0.5N 
3) Tapered Cone Form 40°Tapered Cone Type 
4) Radial Run-out 15um(p-p)MAX * 

* The radial run-out volume is the maximum value when the disc is clamped. 

Interface 
1) Machine Control LAN 

Handler I/F(Hirose S-1634) 
Front Panel SW 

Other 
1) Size W:300mm,H:600mm,D:500mm 
2) Weight 40kg 
3) Laser Class Class 1 
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1.2 Main Body 
1.2.1 Main Body External Dimensions 
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1.2.2 Part Names 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Side cover 

Front cover 

Front panel 

Top cover 

Disc guide 

Disc tray 

Side cover 

Rear cover 
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1.2.3 Front Section Details 

 

1 

2 

4 

3 

5 

8 

7 

6 9 

1. Operation Panel .............................The panel used to operate the main body. (See Section 1.2.4 for details.) 
2. Monitor Board Cover......................When the cover is opened, the monitor pin for confirming the status of the main 

body and the RS232C connector are visible.  
3. Air Supply Port ...............................A mechanically controlled air supply port. Use a tube with a ∅6.0 external 

dimension. The supplied air pressure is 0.5±0.05Mpa.  
4. Intake Port ....................................An intake port to internally cool the main body.  
5. AC Inlet ..........................................An AC power inlet. Handles AC90–230V.  
6. Power Breaker .............................Turns on/shuts off power to the main body.  
7. Handler Interface ..........................Used to communicate with external disc handling devices.  
8. LAN Connector ..............................Connects to the host computer from the main body via a hub or router.  
9. Extension Connector......................Allows the power supply from an external signal to the laser or motor to be cut.  
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1.2.4 Operation Panel Details 
 

 

 

8 7 6
1 

2 

3 

4 5

1. POWER LED.................................Lights when power is on.  
2. AUTO LED.....................................Lights during automatic operation.  
3. LASER ON LED.............................Lights when laser is on.  
4. START SW.....................................Used during manual operations to start BCA recording.  
5. RESET SW ....................................Used to recover from errors.  
6. EMERGENCY STOP SW ..............Used in emergencies. Turn knob to the right to release.  
7. Selector SW...................................Select a main body operation. Functions when breaker is on.  

OFF.............................................Stops main body operations.   
MANU .........................................Manual operation. Used during maintenance and condition output.  
AUTO..........................................Automatic operation. Used during production.   
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8. Status Monitor ................................Displays the main body operating status in seven segments.  

The displays are as indicated in the chart below.  
Status Monitor Display Display Information Note 

 

Display during BCA recording.  
The “ ” symbol rotates.   

 

 
Indicates an error.  
Indicates that Error 255 has occurred.  

See Chapter 6 for a detailed chart of 
error codes.  

 
Indicates maintenance mode.  
The bar flashes.  

See Chapter 5 for directions on 
starting maintenance mode.  

The displays indicated in the chart below can be viewed by switching DIP switch #4 from On to Off. After the 4th time, 
the display returns to 0 (normal status).  

No. Monitor Display Display Information 

0  Normal idle status or no display.  

1  
Scroll displays the MAC ID. 
Consists of 2 hexadecimals x 6.  

2  
Scroll displays the IP address.  
Consists of 3 decimal numbers x 4.  

3  Displays the sequence operations during BCA recording in steps. 

Displays the status of the conveyer.  
From the display left: 
• Spindle status 
• Spindle side tray/disc status 
• Disc guide side tray/disc status 
• Disc guide status 
 

 Raised position 

 Middle point 
Spindle 

Disc Guide 

 Lowered position 

 Origin point position 

 Rotating 

 Origin point: There is a disc on the disc guide side 

4  

Tray 
Disc 

 Origin point: There is a disc on the spindle side 
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1.3 Application Information 
1.3.1 Main Screen 

The screen consists of four main sections.  

 

A 

D

C

B 

 

A. Menu Bar  

[File]  Creates, reads, and saves data in BCA data format.  

 
BCA Data Format File New....................Creates new BCA data format file. 
BCA Data Format File Open ..................Opens existing BCA data format file.  
BCA Data Format File Save As..............Saves the created BCA data format file.  
Exit .........................................................Exits the application.  

 

[View] Used to change the screen configuration.  

 
Toolbar ...................................................Displays a toolbar beneath the menu bar when checked.  
Status Bar ..............................................Displays a status bar at the bottom of the screen when checked.  
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[Mode] Used to switch to the various modes. 

 
Standard................................................. The mode used for line production. Various parameters and data cannot be 

changed in this mode.  
Professional ...........................................Various parameters and data can be changed, and the maintenance mode 

can be accessed in this mode. Password input required when selected.  
Change Password..................................Changes the currently set password.  
 

[Setting] Used to set communications with BW10.  

 
System ...................................................Sets allocation to BW10 units connected to the host PC.  
 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Lists the MAC ID of the allocated units.

Update button 
Searches and updates list of BW10 units connected to the computer 

OK button 
Updates settings and closes window. 
Cancel button 
Closes window without updating settings. 

Unit allocation button 
Displays the units that can be allocated. The grayed-out units are already
selected and cannot be allocated. 

Delete unit button 
Deletes selected MAC ID from registered units. 

Lists the MAC ID of communication-ready devices 
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[BCA] Used to set BCA details.  

 
BCA Format ...........................................Sets BCA format.  
BCA Data ...............................................Sets BCA data.  
 
* See Chapter 2 for the setup method.  
 

[Help] Used to check the BW10 status.  

 
About......................................................Displays the application/BW10 firmware version.  

Press the OK button to close the window.  

 
I/O Monitor Help.....................................Displays a table associated with the handling I/O monitor.  

Press the OK button to close the window.  
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B. Unit Window 

Displays the status of BW10 units connected to the host PC.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Right-click menu 

Right-click on the target unit to display the menu indicated below.  

 
OK,NG Count Clear ............................... Zeroes the current counter (Total/OK/NG) count.   
Pass Mode .............................................Sets the selected unit to not produce.  
Maintenance Mode ................................Switches to maintenance mode.  
Reconnect..............................................Not used.  
Reset......................................................Reboots the main body.  
Firmware Download ...............................Downloads firmware to the main unit.  

 See Chapter 7 for details.   

 

Displays the selected operation mode. 
Auto.................... Automatic operation mode.  
Manual ............... Manual operation mode. 
Maintenance....... Maintenance mode.  
Power off ............ Not connected or power is off.  

Displays the current operating status.

The control number of the connected BW10 unit.
Can be changed using [Setting]. 

Indicates BCA recording result. 

Indicates number of times BCA has been read, number OK, and number NG
to this point. 

Indicates the handling I/O status. 
* See I/O Monitor Help for info about the associated numbers. 
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C. System Window 

Displays the production results/status of connected BW10 units.  

 

 

 

 

 
 

 

 

 

 

 

 

 
* See Chapter 2, Section 2.3 for setup of items below “Order”. 

 

Indicates the end number.

Indicates the number remaining.

Indicates the start number.

Indicates output relative to gross production number with gain. 

Indicates the order number (expected production number).

Indicates the current last number.

Displays the total read number, OK number, and NG 
number of all the currently connected units. 

Indicates the OK percentage of the current production number.
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D. Log Window 

Indicates the errors that occurred for each unit. 

 
No. ......................................................... Indicates the line number.  
Date/Time...............................................Date and time the error occurred.  
Unit......................................................... Indicates the unit number of the target main unit.  
Code ...................................................... Indicates the error code.   
Contents................................................. Indicates the error details.  
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1.3.2 Parameters 
Left-click on each unit on the main screen and input a password to open the sub-windows 
indicated below.  
All selections are masked in standard mode; no settings can be made or edited.  
The configured information is displayed during startup.  
 

Common 

 

A. PUH Information 

Indicates the PUH information being used by the selected unit (main unit). 
Type ....................................................... Indicates the type.  
Serial Number ........................................ Indicates the serial number. 
Used Time [h]......................................... Indicates the time used to this point.  
LD1/LD2 (both) 
1W PowerVolt [V] ...................................D/A value to illuminate with 1W.  
Maximum Power [W].............................. Indicates the maximum outgoing radiation.  
Beam Length [um].................................. Length of the radial direction beam.  

A 

C

D

Indicates the unit being edited. 

B 

B.  

Comment ...............................................Comments can be added.  
Media Type ............................................Select the target media type.  
Layer Type .............................................Select the target media layer. * Not currently being used.  
Calibration Interval ................................. The laser power is calibrated every nth set disc recording.  
Feed 
Home Offset [um]...................................Sets the feed offset. Normally not to be changed.  

Write Feed ........ The BCA recording side feed offset.  
Read Feed ........ The BCA reading side feed offset.  
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C. Setting Extent 

Start Radius [mm] .................................. The start radius position where feed motor writing is possible on the write 
side.  

End Radius [mm] ................................... The end radius position where feed motor writing is possible on the write 
side.  

Minimum CAV [rpm] ............................... Indicates the minimum number of spindle motor rotations.  
Maximum CAV [rpm] .............................. Indicates the maximum number of spindle motor rotations.  
 

D. Common Buttons 

Used in all tabs.  
Open ......................................................Opens the parameter file.  
Save As..................................................Saves the parameter file in the desired folder.  
OK..........................................................Sends the edited parameters to the main unit and closes the sub-windows.  
Cancel....................................................Cancels sending of the edited parameters to the main unit and closes the 

sub-window. Any changes will not be reflected when the window is next 
opened. The latest main unit parameters are displayed.  

Apply ...................................................... The edited parameters are sent to the main unit. The sub-window does not 
close.  
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BCA 

Parameters for recording BCA to the target media.  

 

B

A 

E. Sets the BCA recording pattern.  

Write Mode.............................................Specifies the recording pattern.  
 BCA ....................Records the set BCA data. This is the default.  
 1T to 5T ..............Records 1 to 5 times T for the 1T set in the parameters.  
HI-LO/LO-HI...........................................Set for the target media.  
LD Control..............................................Selects the LD to use. When 1LD is set, the maximum power displayed in 

PUH Information on the Common tab is the maximum value that can be set 
by P0–P2. 

P0 [W] ....................................................Sets power not on the stripes section.  
P1,P2 [W]...............................................Sets power on the stripes section.  
P2 Delay*, P2 Time* [us]........................Allows the P2 irradiation timing delay/illumination time to be set.  
BCA Stripes Time* [us]...........................Sets the laser emission time for the BCA stripes section.  
1T Time* [us] ..........................................Sets the 1T time.  
Layer ......................................................Comments can be added.  
Start Radius [mm] ..................................Sets the BCA recording start position.  
End Radius [mm] ...................................Sets the BCA recording end position.  
Search Power [W] .................................. The power to apply the servo to the target media.  

Set a power level that will not negatively affect the disc.  
Focus Gain [%] ...................................... The focus gain. Normally set to 50% 
Focus Offset [%] .................................... The focus offset. Normally set to 50%.  
Feed Pitch [um/r].................................... The feed pitch during BCA recording. At a maximum, set to 5 um or greater 

less than the PUH beam length being used (Feed Pitch • PUH beam 
length-5 um). 

 
* The time that is set here is based on the theoretical (time) value during BCA playback rotation from the media 

specifications set for Media Type on the Common tab. The actual playback waveform may be before or after the set 
time due to BCA recording conditions and reflection or recording layer characteristics.   
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F. Compare (Verify) Function 

The PUH used for recording can be used for comparisons (may not apply to all media types). 

The timing execution is after BCA recording.  

Limited if Wave Check on the Common tab is not checked.  

Compare ................................................A comparison is done. Active when checked.  
Interval ................................................... The comparison is made every nth set disc recording.  
Radius [mm]...........................................Sets the radius position for the comparison.  
Read Power [W].....................................Sets the emission power during playback.  
CAV [rpm]...............................................Sets the rotation number during comparison.  
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1.3.3 Mode Operations 
The restricted commands for each mode are indicated below.  

×: Cannot be used (cannot be edited)/ : Can be used 

MANU AUTO Menu Bar 
Standard Professional Standard Professional

BCA Data Format File New ×  ×  
BCA Data Format File Open ×  ×  
BCA Data Format File Save As ×  ×  

File 

Exit     
Toolbar     

View 
Status Bar     
Standard     
Professional     Mode 
Change Password ×  ×  

Setting System ×  ×  
BCA Format ×  ×  

BCA 
BCA Data ×  ×  
About     

Help 
I/O Monitor Help     

 

MANU AUTO 
Sub-windows 

Standard Professional Standard Professional
Common ×  × × 
BCA ×  × × 

 

MANU AUTO Right-click Menus (during normal 
operation) Standard Professional Standard Professional

OK,NG Count Clear ×  ×  
Pass Mode × ×   
Maintenance Mode ×  × × 
Reconnect - - - - 
Reset × × × × 
Firmware Download × × × × 

 

MANU AUTO 
Right-click Menus (IPL) 

Standard Professional Standard Professional
OK,NG Count Clear × × × × 
Pass Mode × × × × 
Maintenance Mode × × × × 
Reconnect - - - - 
Reset ×  × × 
Firmware Download ×  × × 
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2.1 Creating BCA Files 
Follow the operation below to create a new BCA file from the application.  

1 On the menu bar, select [Mode] → [Professional]. 

Enter the assigned password.  

 

* This operation is not required if “Professional” is already checked.  

2 Select [File] → [BCA Data Format File New]. 

 

3 Enter the assigned password.  

 

4 Enter the desired file name and save.  

In the example below, “Sample data” is used.  

 

The extension is set as BFF.  
 

The new file has now been prepared.  
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2.2 Setting BCA Format 
Follow the operation below to set the BCA format.  

1 On the menu bar, select [BCA] → [BCA Format]. 

 

2 Enter the assigned password.  

 

3 The format for each item is specified on the screen below. (The screen is for reference only.)  

Set each item by double-clicking with your mouse or click the control button to operate. 

To delete a line, set [Type] to be blank.  

Click the [OK] button to update the set files and close the window.  
  Media Type 

 Selects the target media type. 
 Field Name 
 Sets an arbitrary item name. 
 Type 
 Selects the data format. 
 Ascii .............. Sets using ASCII format. 
 Hex ............... Sets using hexadecimal. 
 Dec ............... Sets using decimal. 
 Dec+Inc......... Increments in decimal. 
 Hex+Inc......... Increments in hexadecimal. 
 Dec+Inc Ascii Incremented in Decimal into an ascii form 
 Hex+Inc Ascii Incremented in Hexadecimal into an ascii form 
 File Ascii........ Sets using Ascii File 
 File Bin.......... Sets using Binaly File 

  Byte 
 Sets data size of that item. 

 
  Data Size [Byte] 

 Maximum size set for Media Type. 
 Used Size [Byte] 
 Total size of the format set for each item. 
 Remain [Byte] 
 Remaining data size.  
 Status Bar 
 The ratio held by each item when data size is 1 is 

displayed as a bar graph. 
 .............. Percentage of items currently selected 

 .............. Currently used percentage (Used Size) 

  .............. Remaining percentage (Remain) 
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2.3 Setting BCA Data 
Follow the operation below to set the BCA format.  

1 On the menu bar, select [BCA] → [BCA Data]. 

 

2 Enter the assigned password.  

 

3 The data for each item is specified on the screen below. (The screen is for reference only.)  

Enter data into the [Parameter] field using the [Type] [Byte] specified for each item. 

 

Details for the item specified as [Dec+Inc] in line 4 of the figure above are set in the details 

section at the bottom part of the screen. 
Order......................................................Sets the production number (order number) for the target media. 
StartNo. ..................................................Sets the start number.  
EndNo. ...................................................Displays the last number that reflects the order number in relation to the 

start number.  
Last No...................................................Displays the last used number during production or during a halt in 

production.  
Remain...................................................Displays the remaining number of orders.  
Clear ......................................................Clears the current production process.  
Status Bar ..............................................Displays as a bar graph the current number of orders with order numbers 

defined as one.  
 
* The information above operates linked to the main screen system window.  
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2.4 Saving BCA Files 
Follow the operation below to save or overwrite the format/data set in Sections 2.2–2.3 above 
using the application.  

1 From the menu bar, select [File] → [BCA Data Format File SaveAs]. 

 

2 Enter the assigned password.  

 

3 Enter a name and save.  

”Sample data” is used in the example below. 
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2.5 Reading BCA Files 
Follow the operation below to read the current BCA file using the application.  

1 On the menu bar, select [File] → [BCA Data Format File Open]. 

 

2 Enter the assigned password.  

 

3 Select and open the desired file.  

In the example below, “Sample data” is used.  

 

After the file is opened, the “Folder Name” and “File Name” are displayed on the main screen 

title bar.  

 

* If no changes are made in the application, the previously selected file will automatically be 

opened the next time the program is started. 
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3.1 Manually Starting the Main Unit 
Follow the procedure below to start up the main unit.  

1 Verify that a key is inserted in the selector switch (key switch) on the operation panel. 

2 Verify that there are no objects that could obstruct operation in the turn tray area.  

If a disc is on the tray, manually rotate the tray and remove the disc.  

3 Turn on the breaker on the front side of the main unit (the knob should move up). 

 

Up is on 

4 Move the selector switch on the face of the main unit to “MANU”.  

 

 

Caution 

 

The turn tray returns to its origin point when the main unit 
is started. Avoid placing hands or objects in the area. 
Serious injury could result. 

5 The POWER LED lights and the main unit starts up.  

6 Once the main unit has completed starting up, a buzzer sounds and operations are possible. 
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3.2 Starting Up the Application 
Follow the procedure below to start up the application.  

1 Select and start “CarveX_BW10.exe” from the file to which the computer installed the 

program. 

 

Once started, the following startup screen is displayed. 

 

2 After the startup screen is displayed, the main screen (see Chapter 1, Section 1.3.1) is 

displayed.  
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3.3 Setting BCA Recording Conditions 
Follow the operations below to set the BCA recording conditions.  

To set the BCA recording conditions, make sure to startup the main unit in “MANU” mode as 
described in Section 3.1. The parameters cannot be set if “AUTO” mode is used.  

In addition, the main unit must be started in order to set the BCA recording conditions.  

1 On the menu bar, select [Mode] � [Professional] to enter Professional mode.  

* This operation is not required if “Professional” is already checked.  

2 Create or open a BCA file for the target media.  

See Chapter 2 for details.  

3 Point your mouse to the target unit on the main screen and double-click.  

Unit 1 is selected below.  

 

4 A sub-window (see figure below) opens. See Chapter 1, Section 1.3.2 to set the parameters 

on the various tabs.  

5 Once the parameters have been set, click the [Apply] button to send all set parameters to  

Unit 1.  
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3.4 Saving BCA Recording Conditions 
Follow the operations below to save the BCA recording conditions.  

1 Click the [Save As] button on the sub-window indicated below. 

 

2 Enter the desired file name and save.  

In the example below, “Sample data” is used.  

 

The extension is set as BWP.  
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3.5 Reading BCA Recording Conditions 
Follow the operations below to read BCA recording conditions.  

1 Click the [Open] button on the sub-window indicated below. 

 

2 Enter the desired file name and save.  

In the example below, “Sample data” is used.  
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3.6  Recording to Target Media 
Configure the settings for items covered under Sections 3.3–3.5 and follow the procedure below to 
record to the target media.  

1 Place the target media into the disc guide on the main unit.  

 
 
 
 
 
 
 
 
 
 

 
2 Verify that there is nothing obstructing the disc transporter, verify that the START switch LED 

on the main unit front panel is blinking, and then press the START switch.  

    

3 The tray rotates and BCA recording starts.  

Warning 

 

Never touch the transporter from the time that 
recording begins until it ends. Injury could result. In 
addition, never place objects in the transporter area. 

4 Once the recording has successfully finished, the tray rotates and the disc is ejected. Remove 

the disc using the RESET switch if an error occurs.  

Warning 

 

Never touch the transporter after the RESET switch 
has been pressed until the disc has been ejected. 
Injury could result.  

 
* See Chapter 6 for information on clearing errors.  
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3.7 BCA Recording Flowchart 
A flowchart explaining the flow of manual operations is indicated below.  

 

 

 
Use application to 

set parameters

Place the media into 
the disc guide 

Verify that the START switch on 
the operation panel is blinking. 

Press the switch. 

Tray turns

BCA recording starts

Tray turns

Media ejected
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transmit parameters

Operation 
done without 

errors? 

Tray turns

Media ejects

Press the 
RESET switch 

End?

Execute with 
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4.1 Parameter Settings 
The parameters used during automatic operations must be set beforehand in manual mode.  

The following settings are made on the main unit and application.  

1 Refer to Chapter 3, Sections 3.1–3.2 to start the main unit and computer application. 

2 Refer to Chapter 3, Sections 3.3–3.5 to send BCA recording conditions to the main unit.  

3 After setting items 1 to 2 above, turn the selector switch on the front of the main unit to 

“AUTO”. 

 

The AUTO LED lights.  

4 The unit window displays the mode as “Automatic” and the device changes to automatic 

operation mode.  
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4.2 Application Side Operations 
The commands that are possible in automatic mode are as indicated below.  

Right-click menu 

 
OK,NG Count Clear ............................... Zeroes the current counter (Total/OK/NG) count.   

After clicking, read and follow the indicated message.  

 
Pass Mode .............................................Sets the selected unit to not produce.  

The screen is as indicated below.  

 
 
* A sub-window with BCA recording conditions is displayed but the settings cannot be changed.  
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4.3 Handler Interface 
The main unit communicates with external control devices through the handler interface on the 
front part of the main unit. The parallel control signal port is as indicated below.  

Pin 
Number Signal Name I/O Signal Description I/O No.

1 Startup signal (+) IN Start operation signal of device DI 0  
2 Startup signal (-)    
3 Supply finished signal (+) IN Disc supply finished signal DI 1 
4 Supply finished signal (-)    
5 Unload finished signal (+) IN Disc unload finished signal DI 2 
6 Unload finished signal (-)    
7 Error reset signal (+) IN Error reset signal DI 3 
8 Error reset signal (-)    
9 Prohibit operation signal (+) IN Handler operation prohibited DI 4 

10 Prohibit operation signal (-)    
11 Finish signal (+) IN Device stopped DI 5  
12 Finish signal (-)    
13 Reserved (+) IN  DI  6  
14 Reserved (-)    
15 Reserved (+) IN  DI  7 
16 Reserved (-)    
17 NC (+)    
18 NC (-)    
19 Running signal (+) OUT Device running DO 0 
20 Running signal (-)    
21 Operating signal (+) OUT BCA recording DO 1 
22 Operating signal (-)    
23 Prohibit operation signal (+) OUT Handler operation prohibited signal DO 2 
24 Prohibit operation signal (-)    
25 Supply possible signal (+) OUT Disc reception possible signal DO 3 
26 Supply possible signal (-)    

27 OK disc acquisition possible signal 
(+) OUT OK disc acquisition request signal DO 4 

28 OK disc acquisition possible signal 
(-)    

29 NG disc acquisition possible signal 
(+) OUT NG disc acquisition request signal DO 5 

30 NG disc acquisition possible signal 
(-)    

31 Error occurred signal (+) OUT Error detected DO 6 
32 Error occurred signal (-)    
33 Disc detection signal (+) OUT Disc detection signal DO 7 
34 Disc detection signal (-)    

I/F Circuit 
Input Output 

  

Photo coupler 44

+ V
BW10 

BW10 
+

44Photo coupler 
2  

G

+  
24V
 

P
otential dif.

TLP521 
or equiv. 

TLP521 
or equiv. 

+ V
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4.4 Timing Charts 
4.4.1 Chart 1: Normal Operations (BCA Cut OK) 

 

Ite
m

Si
gn

al
D

ev
ic

e 
R

un
ni

ng
Ｒ
ｕ
ｎ
ｎ
ｉｎ
ｇ

D
ev

ic
e 

O
pe

ra
tio

n
D

is
ab

le
d

O
pe

ra
tio

n 
D

is
ab

le

D
is

c 
M

ou
nt

in
g

E
na

bl
ed

M
ou

nt
 E

na
bl

e

O
K 

D
is

c 
Ej

ec
t

R
e q

ue
st

ed
O

K
 E

je
ct

 E
na

bl
e

N
G

 D
is

c 
E

je
ct

R
eq

ue
st

ed
N

G
 E

je
ct

 E
na

bl
e

E
rr

or
 D

et
ec

tio
n

E
rr

or
 D

et
ec

t

D
is

c 
D

et
ec

tio
n

(S
up

pl
y)

D
is

c 
D

et
ec

t (
D

is
c 

S
up

pl
y)

D
is

c 
D

et
ec

tio
n

(P
U

H
)

D
is

c 
D

et
ec

t (
P

U
H

)

D
ev

ic
e 

O
pe

ra
tio

n
S

ta
rt

S
ta

rt

D
is

c 
S

up
pl

y
C

om
pl

et
e

M
ou

nt
 C

om
pl

et
e

D
is

c 
Ej

ec
tio

n
C

om
pl

et
e

E
je

ct
 C

om
pl

et
e

E
rr

or
 R

es
et

E
rr

or
 R

es
et

H
an

dl
er

 O
pe

ra
tio

n
D

is
ab

le
d

O
pe

ra
tio

n 
D

is
ab

le

Fo
rc

ed
 D

is
ch

ar
ge

(P
ro

du
ct

io
n

Fi
ni

sh

D
ef

au
lt 

D
ev

ic
e 

S
to

p
Te

rm
in

at
e 

(E
m

er
ge

nc
y 

S
to

p)

M
od

e 
C

ha
ng

e
D

is
ab

le
d

M
od

e 
C

ha
ng

e 
D

is
ab

le
2 A

D
ev

ic
e 

R
un

ni
ng

W
ai

tin
g 

fo
r O

K
D

is
c 

Ej
ec

t

W
ai

tin
g 

fo
r D

is
c

Su
pp

ly

Tr
ay

R
ot

at
io

n
Tr

ay
R

ot
at

io
n

W
ai

tin
g 

fo
r D

is
c

Su
pp

ly

Tr
ay

R
ot

at
io

n

Su
pp

ly
 o

f T
hi

rd
 D

is
c

Ej
ec

tio
n 

of
 S

ec
on

d 
D

is
c

W
ai

tin
g 

fo
r D

is
c

Su
pp

ly

D
is

c
Su

pp
ly

D
is

c
Ej

ec
t

S
up

pl
y 

of
 F

irs
t D

is
c

S
up

pl
y 

of
 S

ec
on

d 
D

is
c

E
je

ct
io

n 
of

 F
irs

t D
is

c

D
is

c
Su

pp
ly

D
is

c
Su

pp
ly

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

D
is

c 
D

et
ec

ti

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

on
 (P

U
H

)

　 D e v i c e  O u t p u t

S i g n a l s

D e v i c e  I n p u t

S i g n a l s

1

４

３

６

１
１

５
1
0

９

７

８

２

１
２

１
２

１
４

１
６

１
９

２
０

１
３

１
５

１
７

１
８

２
１

２
３

２
４

２
５

２
６

２
７ １
３

１
４ １
５

１
６

１
７

１
８

１
９

２
２

4-5 



Chapter 4 Automatic Operations 

TYPE-1 Timing Chart 1: Normal Operation (BCA Cut OK) 

1. The output signal “Running” turns “ON” when the device is turned on.   
2. The input signal “Start” is verified as “ON”.  

2A. “Mode Change Disable” is verified as “ON” and operation of the selector switch is disabled. 
3. After the input signal “Start” is verified as “ON”, the output signal “Operating” turns “OFF” and the 

output signal “Operation Disable” turns “ON”.  
4. After the input signal “Start” is verified as “OFF”, the output signal “Mount Enable” turns “ON”.  
5. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 

“Operation Disable” to “OFF” and starts disc supply.   
6. After discs supplied by the handler are detected by the disc detection sensor, the output signal 

“Disc Detect” turns “ON”.   
7. After verifying that the output signal “Disc Detect” is “ON”, the handler turns the input signal 

“Mount Complete” to “ON”.  
8. After the input signal “Mount Complete” is verified as “ON”, the output signal “Mount Enable” turns 

“OFF".  
9. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 

“Mount Complete” to “OFF”.  
10. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 

“Operation Disable” to “ON”.  
11. After the input signal “Mount Complete” is verified as “OFF” and after the input signal “Operation 

Disable” is verified as “ON”, the output signal “Operation Disable” turns “OFF”, and if the output 
signal “Disc Detect (on the disc supply side)” and the BCA cut operation is finished, then the tray 
rotates.  

12. If there are no discs in the disc supply/output sides after the tray finishes rotating, the output signal 
“Disc Detect” turns “OFF” and “Mount Enable” turns “ON”.  

13. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc supply.   

14. After discs supplied by the handler are detected by the disc detection sensor, the output signal 
“Disc Detect” turns “ON”.   

15. After verifying that the output signal “Disc Detect” is “ON”, the handler turns the input signal 
“Mount Complete” to “ON”.  

16. After the input signal “Mount Complete” is verified as “ON”, the output signal “Mount Enable” turns 
“OFF".  

17. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 
“Mount Complete” to “OFF”.  

18. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 
“Operation Disable” to “ON”.  

19. After the input signal “Mount Complete” is verified as “OFF” and after the input signal “Operation 
Disable” is verified as “ON”, the output signal “Operation Disable” turns “OFF”, and if the BCA cut 
operation is finished, then the tray rotates.  

20. If there are OK discs on the disc supply/output sides after the tray finishes rotating, the output 
signal “OK Eject Enable” turns “ON” and a “Get OK Disc” request is output.  

21. After verifying that the output signal “OK Eject Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc transport.    

22. Discs are transported by the handler, and when the disc sensor detects that there are no discs 
present, the output signal “Disc Detect” turns “OFF”.  

23. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 
“Eject Complete” to “ON”.  

24. After the input signal “Eject Complete” is verified as “ON”, the output signal “OK Eject Enable” 
turns “OFF".  

25. After verifying that the output signal “OK Eject Enable” is “OFF”, the handler turns the input signal 
“Eject Complete” to “OFF”.  

26. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 
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“Operation Disable” to “ON”.  
27. After the input signal “Operation Disable” is verified as “ON”, the output signal “Mount Enable” 

turns “ON” and waits for the next disc to be supplied.  
 

This process repeats from step 13. If no disc is detected in step 20, processing repeats from step 12.  
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4.4.2 Chart 2: Normal Operations (BCA Cut NG) 

 
 

Ite
m

Si
gn

al
D

ev
ic

e 
R

un
ni

ng
Ｒ
ｕ
ｎ
ｎ
ｉｎ
ｇ

D
ev

ic
e 

O
pe

ra
tio

n
D

is
ab

le
d

O
pe

ra
tio

n 
D

is
ab

le

D
is

c 
M

ou
nt

in
g

E
na

bl
ed

M
ou

nt
 E

na
bl

e

O
K 

D
is

c 
E

je
ct

R
e q

ue
st

ed
O

K 
Ej

ec
t E

na
bl

e

N
G

 D
is

c 
Ej

ec
t

R
eq

ue
st

ed
N

G
 E

je
ct

 E
na

bl
e

E
rr

or
 D

et
ec

tio
n

E
rr

or
 D

et
ec

t

D
is

c 
D

et
ec

tio
n

(S
up

pl
y)

D
is

c 
D

et
ec

t (
D

is
c 

S
up

pl
y)

D
is

c 
D

et
ec

tio
n

(P
U

H
)

D
is

c 
D

et
ec

t (
P

U
H

)

D
ev

ic
e 

O
pe

ra
tio

n
S

ta
rt

S
ta

rt

D
is

c 
Su

pp
ly

C
om

pl
et

e
M

ou
nt

 C
om

pl
et

e

D
is

c 
Ej

ec
tio

n
C

om
pl

et
e

E
je

ct
 C

om
pl

et
e

E
rr

or
 R

es
et

E
rro

r R
es

et

H
an

dl
er

 O
pe

ra
tio

n
D

is
ab

le
d

O
pe

ra
tio

n 
D

is
ab

le

Fo
rc

ed
 D

is
ch

ar
ge

(P
ro

du
ct

io
n

Fi
ni

sh

D
ef

au
lt 

D
ev

ic
e 

S
to

p
Te

rm
in

at
e 

(E
m

er
ge

nc
y 

St
op

)

M
od

e 
C

ha
ng

e
D

is
ab

le
d

M
od

e 
C

ha
ng

e 
D

is
ab

le

D
ev

ic
e 

R
un

ni
ng

W
ai

tin
g 

fo
r D

is
c

Su
pp

ly

Tr
ay

R
ot

at
io

n
Tr

ay
R

ot
at

io
n

W
ai

tin
g 

fo
r D

is
c

Su
pp

ly

Tr
ay

R
ot

at
io

n

S
up

pl
y 

of
 F

irs
t D

is
c

S
up

pl
y 

of
 S

ec
on

d 
D

is
c

E
je

ct
io

n 
of

 F
irs

t D
is

c

D
is

c
S

u p
pl

y

W
ai

tin
g 

fo
r D

is
c

S
u p

pl
y

D
is

c
Su

pp
ly

W
ai

tin
g 

fo
r N

G
D

is
c 

Ej
ec

t

D
is

c
E

je
ct

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

D
is

c 
D

et
ec

tio
n 

(P
U

H
)

S
up

pl
y 

of
 T

hi
rd

 D
is

c
E

je
ct

io
n 

of
 S

ec
on

d 
D

is
c

2A

D
is

c
Su

pp
ly

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

D
is

c 
D

et
ec

tio
n 

(S
up

pl
y)

D e v i c e  O u t p u t

S i g n a l s

D e v i c e  I n p u t

S i g n a l s

１

４

３

５
10

６

９

１
１

７

８

２

１
２

１
２

１
３

１
４ １
５

１
６

１
７

１
８

１
９

２
１

２
３

２
４

２
５

２
６

２
７ １
３

１
４ １
５

１
６

１
７

１
８

１
９

２
２

２
０

4-8 



Chapter 4 Automatic Operations 

Timing Chart 2: Normal Operations (BCA Cut NG) 

1. The output signal “Running” turns “ON” when the device is turned on.   
2. The input signal “Start” is verified as “ON”.  

2A. “Mode Change Disable” is verified as “ON” and operation of the selector switch is disabled. 
3. After the input signal “Start” is verified as “ON”, the output signal “Operating” turns “OFF” and the 

output signal “Operation Disable” turns “ON”.  
4. After the input signal “Start” is verified as “OFF”, the output signal “Mount Enable” turns “ON”.  
5. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 

“Operation Disable” to “OFF” and starts disc supply.   
6. After discs supplied by the handler are detected by the disc detection sensor, the output signal 

“Disc Detect” turns “ON”.   
7. After verifying that the output signal “Disc Detect” is “ON”, the handler turns the input signal 

“Mount Complete” to “ON”.  
8. After the input signal “Mount Complete” is verified as “ON”, the output signal “Mount Enable” turns 

“OFF".  
9. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 

“Mount Complete” to “OFF”.  
10. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 

“Operation Disable” to “ON”.  
11. After the input signal “Mount Complete” is verified as “OFF” and after the input signal “Operation 

Disable” is verified as “ON”, the output signal “Operation Disable” turns “OFF”, and if the output 
signal “Disc Detect (on the disc supply side)” and the BCA cut operation is finished, then the tray 
rotates.  

12. If there are no discs in the disc supply/output sides after the tray finishes rotating, the output 
signal “Disc Detect” turns “OFF” and “Mount Enable” turns “ON”.  

13. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc supply.   

14. After discs supplied by the handler are detected by the disc detection sensor, the output signal 
“Disc Detect” turns “ON”.   

15. After verifying that the output signal “Disc Detect” is “ON”, the handler turns the input signal 
“Mount Complete” to “ON”.  

16. After the input signal “Mount Complete” is verified as “ON”, the output signal “Mount Enable” turns 
“OFF".  

17. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 
“Mount Complete” to “OFF”.  

18. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 
“Operation Disable” to “ON”.  

19. After the input signal “Mount Complete” is verified as “OFF” and after the input signal “Operation 
Disable” is verified as “ON”, the output signal “Operation Disable” turns “OFF”, and if the BCA cut 
operation is finished, then the tray rotates.  

20. If there are OK discs on the disc supply/output sides after the tray finishes rotating, the output 
signal “NG Eject Enable” turns “ON” and a “Get NG Disc” request is output.  

21. After verifying that the output signal “NG Eject Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc transport.    

22. Discs are transported by the handler, and when the disc sensor detects that there are no discs 
present, the output signal “Disc Detect” turns “OFF”.  

23. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 
“Eject Complete” to “ON”.  

24. After the input signal “Eject Complete” is verified as “ON”, the output signal “OK Eject Enable” 
turns “OFF".  

25. After verifying that the output signal “OK Eject Enable” is “OFF”, the handler turns the input signal 
“Eject Complete” to “OFF”.  

26. After verifying that the input signal “Mount Complete” is “OFF”, the handler turns the input signal 
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“Operation Disable” to “ON”.  
27. After the input signal “Operation Disable” is verified as “ON”, the output signal “Mount Enable” 

turns “ON” and waits for the next disc to be supplied.  
 

 This process repeats from step 13. If no disc is detected in step 20, processing repeats from 
step 12.  
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4.4.3 Chart 3: Error Detection (cleared by terminate signal) 
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Timing Chart 3: Error Detection (cleared by terminate signal) 

1. When an error* occurs, the output signals “Operation Disable” and “Error Detect” turn “ON”, and 
the output signals “Mount Enable”, “OK Eject Enable”, “NG Eject Enable”, and “Disc Detect” turn 
“OFF”. 

2. When the handler reset switch is pressed, the input signals “Error Reset” and “Operation Disable” 
turn “ON” and other input signals turn “OFF”.  
The device turns the output signal “Operation Disable” to “OFF” and executes error recovery 
processing.  
(The input signal “Error Reset” turns "OFF” about 1 second later.) 

3. Once error recovery processing is finished, all output signals turn “OFF” and the device restarts 
the automatic execution sequence.  

4. Once the automatic execution sequence has restarted, the output signal “Running” turns “ON”.  
5. The input signal “Start” is verified as “ON”.  

2A. “Mode Change Disable” is verified as “ON” and operation of the selector switch is disabled. 
6. After the input signal “Start” is verified as “ON”, the output signal “Operating” turns “OFF” and the 

output signal “Operation Disable” turns “ON”.  
7. If there are discs in the disc supply/output trays, the output signals “NG Eject Enable” and “Disc 

Detect” turn “ON” and “Get disc” is requested. If there are no discs in the disc supply/output trays, 
processing is executed from step 14.  

8. After verifying that the output signal “NG Eject Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc transport.    

9. Discs are transported by the handler, and when the disc sensor detects that there are no discs 
present, the output signal “Disc Detect” turns “OFF”.  

10. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 
“Eject Complete” to “ON”.  

11. After the input signal “Eject Complete” is verified as “ON”, the output signal “NG Eject Enable” 
turns “OFF”.  

12. After verifying that the output signal “NG Eject Enable” is “OFF”, the handler turns the input signal 
“Eject Complete” to “OFF”.  

13. After verifying that the input signal “Eject Complete” is “OFF”, the handler turns the input signal 
“Operation Disable” to “ON”.  

14. After verifying that the input signal “Operation Disable” is “ON”, the device turns the output signal 
“Mount Enable” to “ON”.  

15. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 
“Finish” to “ON”. (Tray rotates without discs being supplied.) 

16. After verifying that the input signal “Finish” is “ON”, the device turns the output signal “Mount 
Enable” to “OFF”.  

17. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 
“Finish” to “OFF”.  

18. After verifying that the input signal “Finish” is “OFF”, the device turns the output signal “Operation 
Disable” to “OFF” and the tray rotates.  

19. If there are discs in the disc supply/output trays, the output signals “NG Eject Enable” and “Disc 
Detect” turn “ON” and “get disc” is requested.  

20. If there are no discs in the disc supply/output trays, processing is executed from step 26.  
21. After verifying that the output signal “NG Eject Enable” is “ON”, the handler turns the input signal 

“Operation Disable” to “OFF” and starts disc transport.    
22. Discs are transported by the handler, and when the disc sensor detects that there are no discs 

present, the output signal “Disc Detect” turns “OFF”.  
23. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 

“Eject Complete” to “ON”.  
24. After the input signal “Eject Complete” is verified as “ON”, the output signal “NG Eject Enable” 

turns “OFF”.  
25. After verifying that the output signal “NG Eject Enable” is “OFF”, the handler turns the input signal 
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“Eject Complete” to “OFF”.  
26. After verifying that the input signal “Eject Complete” is “OFF”, the handler turns the input signal 

“Operation Disable” to “ON”.  
27. After verifying that the input signal “Operation Disable” is “ON”, the device turns the output signal 

“Mount Enable” to “ON”.  
 

* When an error is detected, the errors that can be cleared by pressing the handler’s reset switch 
are listed below.  
– Errors caused by an emergency stop of the handler.  
– Errors caused by no discs.  
 
* Because it is not known whether the discs being transported are OK or NG after clearing an error 
and restarting, the discs are sent as NG discs.  
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4.4.4 Chart 4: Error Detection (cleared by RESET switch) 
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Timing Chart 4: Error Detection (cleared by RESET switch) 

1. When an error* occurs, the output signals “Operation Disable” and “Error Detect” turn “ON”, and 
the output signals “Mount Enable”, “OK Eject Enable”, “NG Eject Enable”, and “Disc Detect” turn 
“OFF”. 

2. When the device’s RESET switch is pressed, the handler turns the input signals “Error Reset” and 
“Operation Disable” to “ON”. After that, if all input signals except for “Reset” are turned “OFF”, the 
device turns the output signal “Operation Disable” to “OFF” and error recovery processing is 
executed. (The input signal “Error Reset” turns "OFF” about 1 second later.) 

3. Once error recovery processing is finished, all output signals turn “OFF” and the device restarts 
the automatic execution sequence.  

4. Once the automatic execution sequence has restarted, the output signal “Running” turns “ON”.  
5. The input signal “Start” is verified as “ON”.  

5A. “Mode Change Disable” is verified as “ON” and operation of the selector switch is disabled. 
6. After the input signal “Start” is verified as “ON”, the output signal “Operating” turns “OFF” and the 

output signal “Operation Disable” turns “ON”.  
7. If there are discs in the disc supply/output trays, the output signals “NG Eject Enable” and “Disc 

Detect” turn “ON” and “get disc” is requested. If there are no discs in the disc supply/output trays, 
processing is executed from step 14.  

8. After verifying that the output signal “NG Eject Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc transport.    

9. Discs are transported by the handler, and when the disc sensor detects that there are no discs 
present, the output signal “Disc Detect” turns “OFF”.  

10. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 
“Eject Complete” to “ON”.  

11. After the input signal “Eject Complete” is verified as “ON”, the output signal “NG Eject Enable” turns 
“OFF”.  

12. After verifying that the output signal “NG Eject Enable” is “OFF”, the handler turns the input signal 
“Eject Complete” to “OFF”.  

13. After verifying that the input signal “Eject Complete” is “OFF”, the handler turns the input signal 
“Operation Disable” to “ON”.  

14. After verifying that the input signal “Operation Disable” is “ON”, the device turns the output signal 
“Mount Enable” to “ON”.  

15. After verifying that the output signal “Mount Enable” is “ON”, the handler turns the input signal 
“Finish” to “ON”. (Tray rotates without discs being supplied.) 

16. After verifying that the input signal “Finish” is “ON”, the device turns the output signal “Mount 
Enable” to “OFF”.  

17. After verifying that the output signal “Mount Enable” is “OFF”, the handler turns the input signal 
“Finish” to “OFF”.  

18. After verifying that the input signal “Finish” is “OFF”, the device turns the output signal “Operation 
Disable” to “OFF” and the tray rotates.  

19. If there are discs in the disc supply/output trays, the output signals “NG Eject Enable” and “Disc 
Detect” turn “ON” and “Get disc” is requested.  
If there are no discs in the disc supply/output trays, processing is executed from step 26.  

20. After verifying that the output signal “NG Eject Enable” is “ON”, the handler turns the input signal 
“Operation Disable” to “OFF” and starts disc transport.    

21. Discs are transported by the handler, and when the disc sensor detects that there are no discs 
present, the output signal “Disc Detect” turns “OFF”.  

22. After verifying that the output signal “Disc Detect” is “OFF”, the handler turns the input signal 
“Eject Complete” to “ON”.  

23. After the input signal “Eject Complete” is verified as “ON”, the output signal “NG Eject Enable” 
turns “OFF".  

24. After verifying that the output signal “NG Eject Enable” is “OFF”, the handler turns the input signal 
“Eject Complete” to “OFF”.  
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25. After verifying that the input signal “Eject Complete” is “OFF”, the handler turns the input signal 
“Operation Disable” to “ON”.  

26. After verifying that the input signal “Operation Disable” is “ON”, the device turns the output signal 
“Mount Enable” to “ON”.  

 
* Detected errors that can be cleared by pressing the device’s RESET switch are indicated below.  

– Errors caused by an emergency stop of the handler. 
– Errors caused by no discs.  

* Because it is not known whether the discs being transported are OK or NG after clearing an error 
and restarting, the discs are sent as NG discs.  
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4.4.5 Chart 5: Production Termination (BCA Cut OK) 
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Timing Chart 5: Production Termination (BCA Cut OK) 

1. If the tray rotates without any disc supply, the handler verifies the output signal “Waiting For Disc” 
and turns the input signal “Finish” to “ON”.  

2. After the BCA cut has finished, if the input signal “Finish” is “ON”, the device turns the output 
signal “Mount Enable” to “OFF”.  

3. After verifying that the input signal “Finish” is “OFF”, the device turns the output signal “Operation 
Disable” to “OFF” and the tray rotates. After the tray rotates, the same processing as the normal 
disc output sequence is done. 

4. If there are no discs on the device and the output signal “Mount Enable” is “ON”, the input signal 
“Finish” is turned “ON” on the handler side.  

5. After verifying that the input signal “Finish” is “ON”, the device turns the output signal “Mount 
Enable” to “OFF”.  
5A. When production is finished, the handler turns “Mode Change Disable” to “OFF”.  

 

After that, processing is done from step 1 of Timing Charts 1 and 2.  
When an error occurs, the output signals “Operation Disable” and “Error Detect” turn “ON”, and the 
output signals “Mount Enable”, “OK Eject Enable”, “NG Eject Enable”, and “Disc Detect” turn 
“OFF”. 
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5.1 Starting Maintenance Mode 
Follow the steps below to start maintenance mode to check main unit operations. 

1 Start up the main unit to be checked using “MANU”, or switch to “MANU” mode.  

2 On the menu bar, select [Mode] → [Professional]* to enter Professional mode.  

* This operation is not required if “Professional” is already checked.  

3 Right-click on the target unit and display the right-click menu. 

Click “Maintenance Mode”. 

 

4 Verify that the mode on the target unit is displayed as “Maintenance”. 

 

5 Double-click on the unit to open a sub-window.  
 

To exit maintenance mode and return to manual mode, right-click on the unit to display the 
right-click menu and remove the “Maintenance Mode” checkmark.  
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5.2 Parameters 
The maintenance mode screen is made up of 4 tabs.  

1 Mecha/Analog Control 
Mainly used for PUH control on the recording side and to check mechanical operation. 

 

Focus Servo ............................Turns the focus servo on/off.  
S-Curve ...................................Moves the pickup head actuator up and down, allows 

S-Curve to be checked.  
Disc Guide...............................Moves the disc guide side air cylinder up and down. 
 Up ...................Moves the disc guide up. 
 Down...............Moves the disc guide down. 
Spindle Side ............................Moves the spindle side air cylinder up and down. 

Used when rotating the spindle motor.  
 Up ...................Moves the spindle motor up. 

Also executes disc chucking. 
 Down...............Moves the spindle motor down. 

Also releases disc chucking. 
Servo Gain ..............................Not currently being used. 
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Spindle ....................................Controls the spindle motor at the specified revolution 

number/linear velocity. 
 CAV.................Rotational speed is specified from 300 to 3,000. Apply the 

value by pressing the “Write” button.  
 CLV .................Not currently being used.  
 Spindle ............The rotational speed of the spindle motor is 

displayed/updated with the “Read” button. 
 Start/Stop.........Rotates/stops the spindle motor.  
 

Caution 

 
Do not touch the disc while it is rotating.  

 
Focus .....................................Changes the focus servo’s gain and offset. Each value is 

specified in a range from 0 to 100%.  
 Gain ................Specifies the gain.  
 Offset...............Specifies the offset.  
 Read ...............Reads/displays the values set for both the gain and 

offset.  
 Write................Writes the values set for both the gain and offset.  
Feed ........................................Used to control the PUH feed motor position for 

recording.  
 Radius.............Specifies the movement radius value or the current 

radius value.  
 Write................Moves to the specified radius value.  
 Read ...............Reads/displays the current radius value.  
 +Limit ..............Moves to the farthest outer position.  
 -Limit ...............Moves to the closest inner position.  
 Home ..............Moves to the home position.  
Servo Analyze ......................... A simple servo analyzer.  
 Cross Frequency ..Specifies the gain crossover frequency.  
 Gain ................Specifies the gain.  
 Phase..............Specifies the phase difference.  
Tray ......................................... Allows control of the transporter rotation tray.  
 Side A/B Offset.....Specifies the spindle chucking position offset value (pulse 

no.). Move to the specified location using the “Write” 
button. The tray moves 0.024° with a single pulse. The 
offset range is specified between 0 (home position) and 
+999 (clockwise). 

 CW ..................The tray rotates clockwise.  
 CCW ...............The tray rotates counterclockwise.  
 Home ..............Rotates and returns to the home position.  
 

Warning 

 

Never rotate the tray or touch the tray while it is 
rotating. A serious injury could result. 
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Laser Power (LD1/LD2)...........The laser can be made to illuminate at the specified D/A 
value.  

 Cal...................The value is specified in a range from 0 to 3,000V.  
 Power..............The current laser power is displayed/updated with the 

“Read” button. 
 D/A ..................The currently set D/A value is read using the “Read” 

button.  
 On/Off..............The laser is illuminated or turned off with the currently set 

Cal value.  
Laser Power BCA (LD1/2) .......The laser can be made to pulse using the specified D/A 

value. The pulse pattern is the pattern set in manual 
mode.  

 Peak................Sets the power. 
 High.................Sets the power. 
Power Check (LD1/2) ..............Checks the D/A value of the specified power.  
 Power..............Specifies the laser power to check. Measure with the 

“Start” button.  
 Power..............Displays the actual measurement value of the laser 

power as it illuminates. 
 D/A ..................Displays the D/A value as the laser illuminates.  
Coil .......................................... Controls the pickup head actuator offset.  
 D/A ..................Specifies the offset value. Set with the “Write” button.  
Sum Comparator ..................... Checks the comparator level to turn the servo on.  
 High D/A..........Not currently being used.  
 Low D/A...........Specifies the low side D/A.  
 Write................Sets the specified D/A.  
 Read ...............Reads the current value with the “Read” button.  
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2 D/A And I/O Monitors 
 

 
 
D/A Correction.........................Displays the correction coefficient set for each channel. 

The “All Read” button is used to read the currently set 
D/A of all channels.  

EVR Data ................................ Displays the values set for each electrical volume. The 
“All Read” button is used to read all numbers.  

Sensor..................................... Monitors the main unit sensors. Gray is off, red and green 
are on.  

 
Disc and Cover PUH and Feed 

Sensor Comments Sensor Comments 
Not Used  Not Used  
Not Used  Not Used  
Not Used  Not Used  
Not Used  Not Used  
Not Used  Spindle Running Spindle motor is running 
Tray Running Tray is turning Spindle PLL Lock Spindle motor PLL 
Tray Sensor A Tray sensor A is ON Feed(-) Feed (-) is ON 
Tray Sensor B Tray sensor B is ON Feed(Z) Feed (Z) is ON 
Not Used  Feed(+) Feed (+) is ON 
Spindle Up Spindle up position Feed Running Feed motor is running 
Spindle Down Spindle down position Spindle Alarm Spindle motor alarm 
Guide Up Disc guide up position Focus Servo Focus servo is ON 
Guide Down Disc guide down position LD2 Peltier LD2 Peltier is running 
PUH Cover PUH cover opening LD1 Peltier LD1 Peltier is running 
Disc Exist 2 Mount side disc exists LD2 Power LD2 laser is operating 
Disc Exist 1 Spindle side disc exists LD1 Power LD1 laser is operating 
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3 A/D,I/O,Self Diagnosis 

 

A/D Data.................................. Displays A/D of CH. 00–17. The “ALL Ch. Read” button 
reads and displays all A/D.  

I/O Data................................... Reads/writes data directly to the control board.  
Self Diagnosis ......................... Runs a main unit self-diagnosis.  
 LD1/2 D/A........Checks the D/A read. Written with “Write”, read with 

“Read”.  
 DIAG ...............A self-diagnosis is done.  
Calibration LD1/2..................... Displays the correction coefficient and the Y slice of the 

currently mounted pickup head.  
 Start.................A calculation is done.  
 Graph ..............After the calculation, a graph is displayed. 
Feed ........................................ Corrects the pickup head stage.  
 Home offset ...Not currently being used.  
 Base Radius....Not currently being used.  
 Base Offset ....Not currently being used.  
 Auto Adjust ......Not currently being used.  
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Memory Switches....................Press the button to open a window and set the memory 

switches.  
The settings are applied at startup.  
 

 

 
 
Handler Interface Timing .........Two types (Type1/2*) can be selected.  

* Currently only Type1 is being used. Do not change 
unless specified.  

Disc Guide operation............... Disc guide can be enabled or disabled.  
Tray A/B Offset ........................ Sets the rotation tray offset. Do not change unless 

specified.  
Spindle Direction ..................... The spindle direction can be selected as clockwise (CW) 

or counterclockwise (CCW). 
Diagnosis LD........................... Diagnoses laser degradation. 
LD NG Level[%] ...................... Sets the specification when laser degradation is 

unacceptable.  
Error reset ope.(Auto/Manual) ...Sets whether to clear the error with the reset switch[r1] 

or automatically.  
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6.1 Troubleshooting 
 

If symptoms indicative of device problems occur during use, follow the flowchart below for the 
proper solution.  

Refer to the relevant pages of the respective user’s manuals to troubleshoot problems on 
other devices.  

Unpleasant odor or 
overheating 

 
Error is displayed on the 
screen 

 
Other operations cannot be 
executed 

 

 

 

Turn power off and 
remove the AC power 
cable from the AC outlet. 

 
Refer to the error code 
table to resolve.  

 
Turn the power off and 
restart the device.  

 

 

 

If symptoms persist, turn 
off power.  

 
If the same error occurs, 
turn off power.  

 

 

 

Contact a Pulstec representative. Be ready to provide specific details about the problematic 
symptoms and the device’s current status. 
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6.2 Error Messages 
The error messages are displayed as indicated in the chart below.  

1 Application display 

 

 

The last three digits indicate
the error code.  
The first two digits indicate the
sequence code. 

2 Main unit display 

 

 

 
Error code display

The “sequence code” and “error code” displayed in the application can be used to determine 
the device status when the error occurred.  
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6.2.1 Sequence Codes 
The sequence code is the first digits of the code in the log window.  

Code Explanation 
0 Waiting 

5 Preparing to start 

10 LD calibration underway 

15 ECC measurement (radial run-out volume) underway 

20 Waiting to receive BCA data 

40 Recording BCA data 

45 Comparing BCA data (signal processing measurement underway) 

80 Beam profile measurement underway 
90 Finish processing underway 
98 Stopping due to error 
99 Stopping due to emergency 

100 Executing maintenance command 
 

6-4 



Chapter 6 Troubleshooting 

 

6.2.2 Error Codes 
The error code is the last three digits of the code in the log window. This code is also 
displayed on the main unit.  

Code Contents Explanation Resolution 
5 Unknown Error ???  Number substituting for an undefined error number 

6 Unknown Message ??? Number substituting for an undefined message 
Contact a Pulstec representative.  

10 EMERGENCY STOP  Emergency stop has occurred  
After resolving the problem, clear the 
emergency stop on the relevant unit 
and press the reset switch.  

11 Terminate Stop  Stopped with a terminate signal 
Contact a Pulstec representative if 
the problem occurs multiple times. 

13 Disc Nothing  No disc to record 

Could be caused by a transport 
malfunction within the unit or a 
sensor malfunction.  
Contact a Pulstec representative.  

14 Disc Exist Error  No disc released  

Could be caused by a transport 
malfunction. 
Turn power off and remove the discs 
from within the main unit.  

30 Spindle malposition Spindle position error 

Check that air is being properly 
supplied.  
If the problem occurs frequently, a 
sensor malfunction could be at fault.
Contact a Pulstec representative.  

31 Spindle status error Spindle operation error  

The motor or driver could be 
malfunctioning.  
Contact a Pulstec representative if 
the problem occurs multiple times. 

32 Disc guide malposition Disc guide position error 

33 Disc guide status error Disc guide operation error 

Check that air is being properly 
supplied.  
If the problem occurs frequently, a 
sensor malfunction could be at fault.
Contact a Pulstec representative.  

34 Disc tray malposition Disc tray position error 

35 Disc tray status error Disc tray operation error 

Check to make sure nothing is 
impeding tray rotation.  
Contact a Pulstec representative if 
the problem occurs multiple times. 

50 
Communication error between 
application  

Error communicating with application 

51 
Communication error between 
BCA server  

Error communicating with BCA server 

Check that the LAN cable is securely 
connected.  
Contact a Pulstec representative if 
the problem occurs multiple times. 

52 
Communication error between 
devices CPU  

Error communicating with control board 

53 
Communication error between 
analyzer  

Error communicating with signal processing device 

54 
Communication command format 
error  

Control command format error 

55 
Communication command that 
doesn't exist  

No control command number 

Contact a Pulstec representative if 
the problem occurs multiple times. 

60 Memory write error  Data cannot be written to memory 

61 Memory read error  Data cannot be read from memory 

The control board may be 
malfunctioning. 
Contact a Pulstec representative.  
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Code Contents Explanation Resolution 

62 Parameter format error  Parameter formats differ 
Check the set BCA format and the 
media tab.  

63 Parameter read error Parameters cannot be read 

64 Parameter write error Parameters cannot be written 

65 The parameter was initialized  Parameter was initialized 

The control board may be 
malfunctioning. 
Contact a Pulstec representative.  

71 The BCA server is not connected  BCA server not connected 

72 The BCA data cannot be acquired BCA recording data cannot be acquired 

Check that the LAN cable is securely 
connected.  
Contact a Pulstec representative if 
the problem occurs multiple times. 

73 The BCA data format is abnormal  BCA recording data abnormal  

74 
Media information is abnormal of 
the BCA data  

BCA recording data media information does not match

75 
There is no serial number of the 
BCA data  

No BCA recording data serial number 

Check the BCA format, data, media 
type.  

76 BCA data writing error  BCA recording NG 
Check the set parameters. 
Contact a Pulstec representative if 
the problem occurs multiple times. 

77 BCA data reading error  BCA read NG 

78 BCA data comparison error  BCA comparison NG 
Check the set parameters.  

90 
The DISC control parameter is 
abnormal.  

Automatic mode cannot be launched (DISC control 
parameter is abnormal) 

If the problem occurs frequently, the 
control board could be at fault. 
Contact a Pulstec representative.  

91 
The CarveX-BW setting parameter 
is abnormal. 

BCA recording/comparison/signal processing control 
not possible 
(device control parameter error)  

Check the set parameters.  
If the problem occurs frequently, the 
control board could be at fault. 
Contact a Pulstec representative.  

100 Feed In Limit Error (Writer) Record side feed internal sensor error 

101 Feed Out Limit Error (Writer) Record side feed external sensor error 

102 Feed Z Sensor Error (Writer) Record side Z sensor error 

103 Feed Home Error (Writer)  Failed to return to record side feed home position 

104 Feed Inner Error (Writer)  Failed to move to record side feed inner periphery 

105 Feed Outer Error (Writer)  Failed to move to record side feed outer periphery 

106 Feed Position Error (Writer) Failed to move to record side feed position 

Turn the power off and restart the 
main unit. 
If the problem occurs frequently, the 
feed unit could be at fault. 
Contact a Pulstec representative.  

107 LD Temperature Error (Writer) LD1 Peltier control error 

108 LD2 Temperature Error (Writer) LD2 Peltier control error 

Turn the power off, wait for 
approximately 30 minutes, and then 
restart the main unit. If the problem 
occurs frequently, the control board 
could be at fault. 
Contact a Pulstec representative.  

110 LD Limit Error (Writer)  Over LD1 limit 

111 LD2 Limit Error (Writer)  Over LD2 limit 

The control board may be 
malfunctioning. 
Contact a Pulstec representative.  

112 LD Deter Error (Writer)  LD1 laser deterioration 

113 LD2 Deter Error (Writer)  LD2 laser deterioration 

114 LD Calibration Error (Writer) LD1 laser calibration failed 

115 LD2 Calibration Error (Writer) LD2 laser calibration failed 

1) The laser may have deteriorated. 
Replace the PUH.  
2) The laser may be malfunctioning.
Contact a Pulstec representative.  
3) The control board may be 
malfunctioning. 
Contact a Pulstec representative.  
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Code Contents Explanation Resolution 
116 DA Write Error (Writer)  LD1 side D/A write error 

117 DA2 Write Error (Writer)  LD2 side D/A write error 

118 AD Read Error (Writer)  LD1 side A/D read error 

119 AD2 Read Error (Writer)  LD2 side A/D read error 

The control board may be 
malfunctioning. 
Contact a Pulstec representative.  

120 LD On Error (Writer)  Laser is on 
Immediately halt use and turn power 
off. 
Contact a Pulstec representative.  

121 SERIAL D/A A/D Error (Writer) Serial D/A A/D control failed 
The control board may be 
malfunctioning. 
Contact a Pulstec representative.  

122 Spindle Alarm Error (Writer) Driver error 

123 Spindle Stop Error (Writer) Could not be stopped 

124 Spindle CAV Error (Writer)  CAV rotation control failed 

125 Spindle Data Error (Writer) Rotation control value error 

126 Spindle Range Error (Writer) Specified rotation number range exceeded 

127 Spindle Rotation Error (Writer) Specified rotation number not achieved 

Turn the power off and restart the 
main unit. If the problem occurs 
frequently, the motor or control board 
could be at fault. 
Contact a Pulstec representative.  

130 Focus Servo Error (Writer)  Focus servo could not be turned on 

131 Focus Change Error (Writer) Focus servo change failed 
Check the set parameters.  

132 Servo Analysis Error (Writer) Simple servo analysis adjustment failed Contact a Pulstec representative.  

140 BCA Data Set Error (Writer) BCA data was not set Set the BCA data.  

141 BCA Data Compare Error (Writer) BCA comparison NG 

150 Application BCA License Nothing No BCA license exists 
Check the set parameters.  

151 Application is different  Different application was started Contact a Pulstec representative.  

160 Receive Timeout  Network timed out 

161 Command Error  Network command error 

Check that the LAN cable is securely 
connected.  
Contact a Pulstec representative if 
the problem occurs multiple times. 

162 Not Enough Memory  Memory error Contact a Pulstec representative.  

163 File Open Error  File open error 

164 File Read Error  File read error 

165 File Write Error  File write error 

The computer may be 
malfunctioning.  
Check the computer.  

166 Communication Port Busy  
Command attempting to be sent even though 
communication port is different 

Contact a Pulstec representative.  

167 BCA Data File Error  BCA data file content incorrect 
The file may be corrupted. 
Set again.  

250 Can't Process Processing that should be executed does not exist 

255 Abnormal Error No error definition 
Contact a Pulstec representative.  

* Contact a Pulstec representative if an error other than those described above is displayed. 
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7.1 Transport/Installation 
Keep the following points in mind when transporting or installing this device in a different location.  

Caution 

• In order to reduce the danger of injury or electrical shock, unplug all 
devices that make up the system.  

• Transport or move the device once all the cables used by the device have 
been unplugged.  

• Use the packaging materials that came with the device to secure it before 
transport.  

• Transporting or moving this device could damage it, causing improper 
operation.  

• The devices that make up this system are all precision instruments. Handle 
with care and be sure not to drop or shake.  

• Avoid placing in a location that does not meet the operating environment 
conditions.  
See the usage environment conditions and specifications for details.  

• Place this device on a flat and stable area that will support the system’s 
total weight. Failure to do so could cause the device to fall over and cause 
injury.  

 

7.2 Spare Parts 
The spare parts used by this system are indicated in the chart below.  

Name Model Number Manufacturer 
PUH SB21A or Pulstec-specified model 

number 
Pulstec Industrial Co., Ltd.  

Safety relay G7S-4A2B-E Omron Corporation 
Front filter FLM12 Oriental Motor Co., Ltd. 
Side filter FLM6 Oriental Motor Co., Ltd. 

 

Caution 

Always use spare parts specified by Pulstec. 
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7.3 Installing the PUH 
Follow the procedure below to install the PUH. 

For the tools, use an M4 hex wrench and Phillips head screwdriver.  

1 Remove the PUH from its case.  

    

 

Pre-amp 

Lens
Short pin 

LD1 connector 

Short pin 

LD2 connector 

Caution 

The PUH is a precision instrument, handle with extreme care.  
Do not touch the parts indicated with a red arrow in the figure above 
when handling the PUH. In addition, do not place the lens facedown 
on a table or similar surface. 

 

2 Use the screwdriver to loosen the 4 screws indicated below and remove the top cover. 

    

Top cover 
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3 Install so that the PUH side holes can receive the positioning pins indicated by the red 

arrows below.  

 

   

 

 

 

PUH 

PUH base 

Caution 

During PUH installation, make sure that no other parts interfere with the lens 
or LD. Take care not to pinch fingers while installing the PUH.  

 

4 Affix the PUH to the PUH base using the included cap screws (M4 x 15, 4 locations). 

Use an M4 hex wrench to tighten. Tighten the cap screws in a crisscross pattern. 

Caution 

Take care not to drop the cap bolts into the main unit during installation. 
Operating the main unit with the bolts inside could cause damage.  
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5 Connect the pre-amp cables (red arrows) and connect the LD1/2 connectors (yellow arrows) 

to the opposite-side connectors as indicated in the figure below.  

   

 

 

 

Pre-amp cable 

LD2 connector 

LD1 connector 

Short pin 

6 Remove the LD protective short pins (light blue arrows) indicated in the figure above. 

Store in a safe place after removal to avoid losing them. 

Caution 

Do not remove the short pins without connecting the LD connectors.  
Doing so could cause LD damage. In addition, do not start up the main 
unit while the short pins are connected.  

 

7 Attach the top cover removed in step “1”.  

 
Do not start up the device without attaching the top cover.  

 

8 Start up the main unit. After it is started, check that the PUH information exchanged by the 

PUH information (see 1.3.2) of the target unit is displayed.  
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7.4 Removing the PUH 
Follow the procedure below to remove the PUH. 

For the tools, use an M4 hex wrench and Phillips head screwdriver. The procedure is the reverse of 
Section 7.3.  

1 Use the screwdriver to loosen the 4 screws indicated below and remove the top cover. 

    

2 Connect the LD protective short pins (light blue arrows, two locations). 

   

 

 

3 Remove the pre-amp cables (red arrows) and LD1/2 connectors (yellow arrows). 

Caution 

Do not remove the LD connectors without connecting the short pins.  
Doing so could cause LD damage.  
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4 Remove the cap screws attaching the PUH.  

Caution 

Take care not to drop the cap bolts into the main unit during removal. 
Operating the main unit with the bolts inside could cause damage.  

 

5 Refer to the figure below to remove the PUH from the main unit.  

Lift up to remove.  

   

 

 

 

6 Place the removed PUH into its case.  
 

7 Attach the top cover removed in step “1”.  

 
Do not start up the device without installing the PUH.  
Do not start up the main unit without attaching the top cover.  
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7.5 Downloading Firmware 
Firmware upgrades are used to add functionality and upgrades, and to resolve problems. The 
procedure for updating firmware is indicated below. See Chapter 1, Section 1.2.1 for information on 
displaying the firmware version information.  

1 Turn the BW10 selector switch to the “OFF” position and turn off the main unit power.  
 

2 Open the cover over the monitor board on the front side of the main unit. (See Chapter 1, 

Section 1.1.3.) Switch DIP switch #3 to the “ON” 

 

3 Turn the selector switch

The device starts up in I

* IPL → MAC ID → IP A

1 2 3 4

[FD F] [SP Z] [SP A] 

[SUM] [FE] [FO-D] [BCA BIN] 

[F MO1] [I MO1][F MO2] [I MO2] [SP-D] 

[FD R] 

ON
 t

P

d

o 

L

d

R
S
-
2
3
2
C

 

t
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he “MANU” position.  

ode.  

 

ss are displayed repeatedly in the 7-segment display. 

[
S
T
RA
I
GH
T
 C
A
B
LE
]

 

１

ON

2 3 4 
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4 From the application, right-click on the target unit and display the right-click menu. 

From “Firm Download” indicated in the figure below, select the downloaded file. 

 

* “SH-CPU 1” is downloaded as an example here. 
 

5 Select the firmware file and click “Open”.  

 

 

6 A dialog box is displayed. To download, click “Yes”.  
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7 The file download starts.  

The following screen is displayed in the application during download.  

 

The START LED flashes when the BW10 is receiving data. The RESET LED flashes when it 

is writing data.  

Caution 

Never turn the main unit power off when updating firmware. In a worst case 
scenario, the device could fail to start and become unusable.  

 

8 When the download is finished, turn the BW10 selector switch to the “OFF” position and turn 

off the main unit power. Return DIP switch #3 to the “OFF”.  
 

9 Wait for 10 seconds or more and start up the main unit. Once the main unit has been started, 

check that the desired firmware has been updated by selecting [Help] → [About]. (See 

Section 1.3.1 for details.)  
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First Edition Published: 02/06/2006 
 

Issued by Pulstec Industrial Co., Ltd. 
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TEL 053-522-3611 FAX 053-522-5622 

 
● No part of this document may be reprinted in any form or by any means. 
● This manual is subject to change without notice.  
● The authors have made every effort to ensure the accuracy and pertinence of the 

content herein, but errors may remain. If you notice any error, omission, or other 
problem with the explanations herein, please contact us and let us know. 

 
� The name Windows® is short for Microsoft® Windows® Operating System. 
� Microsoft and Windows are registered trademarks of the Microsoft Corporation in the USA and other countries. 
� Other company names and product names used herein are trademarks or registered trademarks of their respective 

owners. 
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